
April 2018

AUGIWorld
T h e  O f f i c i a l  P u b l i c a t i o n  o f  A u t o d e s k  U s e r  G r o u p  I n t e r n a t i o n a l

Diamond Sponsors 

Introducing 
Autodesk 
2019

Also in this issue:
•	 Smart Schedules in Revit MEP

•	 A CAD Manager’s Advice, Part 2

•	 Tips & Tricks for AutoCAD 
Architecture



http://hp.com/go/autodeskThe next giant leap for humankind. We invite  
you to imagine, create, and virtually experience  

a sophisticated civilization on Mars. A new  
home for one million humans.

R E I N V E N T  L I F E  O N  M A R S

J O I N  N O W
hp.com/go/mars

Image includes: Biosphere 2 at the University of Arizona

© 2017 HP Development Company, L.P. NVIDIA and Quadro are trademarks and/or registered trademarks of NVIDIA Corporation in the U.S and other countries. All other trademarks are the property of their respective owners.

P O W E R E D  B Y

http://hp.com/go/autodesk
http://cgar.ch/1Znvgdt


April 2018 www.augiworld.com

contents

columns

28 34

6 22

AUGIWorld A
P

R
IL

 2018

3

The next giant leap for humankind. We invite  
you to imagine, create, and virtually experience  

a sophisticated civilization on Mars. A new  
home for one million humans.

R E I N V E N T  L I F E  O N  M A R S

J O I N  N O W
hp.com/go/mars

Image includes: Biosphere 2 at the University of Arizona

© 2017 HP Development Company, L.P. NVIDIA and Quadro are trademarks and/or registered trademarks of NVIDIA Corporation in the U.S and other countries. All other trademarks are the property of their respective owners.

P O W E R E D  B Y

Cover Image:
Doha Museum of Islamic Art
Copyright © 2018 Phil Lazarus

4 Letter from the President

14  CAD Manager

20  Inside Track

6 AutoCAD New Look, New Features

10 Revit MEP Making Schedules Smart

16 Revit Structure Manage This!

22 AutoCAD Architecture Tips & Tricks

28 AutoCAD Civil 3D What’s New in  
Civil 3D 2019?

32 InfraWorks Enhanced Functionality  
for Roads, Bridges, and More

http://www.augiworld.com
http://cgar.ch/1Znvgdt


www.augi.com April 2018

 
P

R
O

D
U

C
T

 F
O

C
U

S 

4

When was the last time you had a day without a software update? It seems 
to me that every time I turn around, something on my phone, computer, 
or tablet wants to tell me that there’s a new version available. In fact, I 
saw it just this morning—my conference call software wanted to update 

from 2.210.1009 to 2.210.1106.

What happened to updating from version 2 to version 3? Is it really necessary to take version numbers 
out to eight significant digits? Any science teacher will tell you that’s a ridiculous level of precision. Is 
whatever new feature that just rolled out really worth it? And never mind the management headaches...
when software releases trickle out like this it’s almost impossible to keep everyone on the same version. 
There’s one product on our network where there are 14 versions currently installed, all between 14.0 and 
14.5. (I wish I were joking.)

All right, that’s enough with the rant. Most of the time, I’m grateful for how easy the update process is 
these days. Remember when you really had to pay attention when a program advised you to “close other 
programs before continuing with the installation”? Now I still save my work before an installation, but 
that’s it. Most installations don’t even require a reboot (even if you should maybe reboot anyway).

When it comes to update philosophies, I think there are generally three types:

•	 The Live Wire: Installs updates the instant they’re available—if it’s automatic, so much the better.

•	 The Resister: Imposes a waiting period on new software, to let everyone else find the bugs before 
risking their own machines.

•	 The Stick-in-the-Mud: Waits as long as possible to change anything; runs updates only when there 
is absolutely no alternative left.

What kind of updater are you?

A one-size-fits-all approach isn’t likely to be the best strategy. On my personal devices, I’m basically a Live 
Wire. I have automatic updates turned on whenever possible, and when they’re not, I don’t usually wait 
too long before letting the update run. In general, I trust that developers don’t try to break things, and 
thanks to redundancy in my storage and programs, even if something does break I’m not likely to be at a 
standstill.

At the office, though, it’s a different story. We have a standard 30-day moratorium on any new program 
or update, unless it’s a critical bug fix. This is to prevent a “bad” update from crashing a product and 
interrupting business for dozens of people at once. Although frankly, we don’t see much crashing these 
days. We’re more often grateful for our waiting period because an “update to the update” gets released two 
weeks after the original update. By waiting a little bit, we save ourselves from having to deploy things twice. 
We’re cautious, but we’re not sticks-in-the-mud either—it’s extremely rare that we would decide to skip 
an update entirely. 

I don’t really have “advice” to conclude with this month… maybe just a request that you look at your 
own software update strategy and make sure it’s reasonable. Test updates thoroughly before rolling out 
something that can affect lots of people, but don’t delay important updates just because they’re a hassle. 
(Hmm, I guess that’s advice after all!)

Before I go, one bit of news from the Board of Directors: Robert Green has stepped down as a Director 
and Treasurer. We’re sorry to see him go, but I’m sure he won’t go far. Chris Lindner is taking over as 
Treasurer, and Kimberly Fuhrman will be our new Secretary. And stepping up to fill out the remainder of 
Robert’s term is Frank Mayfield, a longtime AUGI member and forum moderator, and a contributor to 
the “Tuesday Tips” series on the AutoCAD blog. Welcome, Frank!

Wondering how you can get involved like Frank? Email me: president@augi.com.

Kate Morrical
AUGI President
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AutoCAD 2019 by: Brian Benton

New Look, 
New 
Features
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AutoCAD 2019

7

I
cons! Icons! Icons! They are all different! Every. 
Single. One. Autodesk has revamped every 
button and clickable graphic in AutoCAD® 
2019. It has a new flat design that is intended to 

display more clearly on higher resolution monitors.

One of the more interesting, and perhaps more useful, updates is the 
new Drawing Compare tool. This tool will come in handy. It looks 
at the linework between two files and displays what is different. If 
the linework is the same it will be grayed out. The differences will 
be either red or green, depending on the file to which it belongs. 
It makes drawing differences easier to determine in an easy-to-see 
visual display. 

Go to the Application Menu when you don’t have a file open. If 
you do have a file open, then go to Drawing Utilities to start the 
DWG Compare tool. The tool is also accessible from the ribbon 
in the Collaborate panel. There are two new commands and 15 
system variables to go along with this tool. COMPARE is the 

actual command. COMPAREINFO will display the dialog with 
information about the two compared files.

Another new tool is the Shared Views feature. It extracts and stores 
data from your file into the cloud and provides a sharable link for 
others to view the drawing. Whoever receives the link will be able 
to view, review, measure, comment, and markup the drawing from 
Autodesk Viewer in their web browser. Shared Views allows you 
to share your drawings with others without having to release your 
CAD files. 

The reviewer can access your drawings from their computer, tablet or 
mobile device. Once they have provided feedback, you will be able to 
see their markups from within AutoCAD. To create Shared Views 
you must have, and be signed into, your Autodesk account and be 
a subscription member. CAD Managers who run a multi-license 
account for a company can grant or restrict access to the company 
users as they see fit.

The Shared Views commands are based 
in a palette, which can be accessed via 
the Collaborate panel on the ribbon. 
This palette will display the views from 
the current file that have been shared. 
This palette also provides the controls 
for the shared links, control of the 
views themselves, as well as responses 
or comments from those who have 
reviewed the shared files.

Views and Viewports have been 
refreshed and are a bit easier to create 
and use. A new Named Views panel 
has been added to the View tab on 
the ribbon, making it easier to create, 

➲

Figure 1: The grayed out linework is the same. The red and green linework indicates what is different.

Figure 2: Access the Shared Views commands via the Application menu.

http://www.augiworld.com
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restore, and edit named views. This provides a simpler version of the 
New View/Shot Properties dialog box, providing the basic controls 
that are more commonly used.

Many times a named view is created that is intended to fill in a 
viewport. It makes creating the view in a viewport easier. Now you 
can make a viewport from a named view. This saves several steps 
in drawing creation. Go to the contextual Layout ribbon tab (when 
a layout tab is activated) and use the Insert View tool. Select the 
named view you want to use and place it into your layout. A preview 
of the view will be displayed, providing a visual guide that will assist 
you in placing the view on the drawing.

Viewports are a bit easier to update. They have built-in grips for 
editing that will allow you to change the scale quickly.

There is a New View tool that will quickly create a viewport by 
allowing you to select the area in model space to be displayed and 
creating a viewport of that view.

Have you ever had trouble getting your drawings to print the way 
you want because somebody didn’t follow standards? Or maybe you 
received CAD files from an outside vendor? The Layer Properties 
Manager has a new status icon that shows when an Xref layer 
contains an override.

There is also a toggle switch to sort the 
layers according to overrides. Now, if you 
right-click on a layer you have the option to 
reset the layer to match what is in the Xref 
file. Very handy. There is also the option 
to remove layer overrides in the command 
line when using -LAYER.

The layer setting dialog box is updated 
(changed) to include new tools for 
managing Xref layer properties. You get 
to it from the settings icon in the Layer 
Manager. The Visretain settings are there 
now and the new ability to treat Xref layer 
objects as bylayer regardless of the object 
settings allows you to override object 

overrides and display the objects in your drawing as you like. This 
is huge for those who work with third-party CAD files often. There 
is a new XREFLAYER system variable that forces Xref files to a 
specified layer when inserted into a drawing. No longer will an Xref 
be on the wrong layer.

Behind-the-scenes tweaking promises faster performance during 
use. It also now supports higher resolution monitors for 4K support.

Brian Benton is a CAD Manager, 
CAD Service Provider, technical writ-
er, and blogger. He has more than 20 
years of experience in various design 
fields (Mechanical, Structural, Civil, 
Survey, Marine, Environmental) and 
is well versed in many design software 
packages (CAD, GIS, Graphics). Bri-
an has been a contributing writer for 
Cadalyst magazine and was their Tip 
Patroller for some time. He has au-
thored AutoCAD training videos for 
Infinite Skills and is co-author of the 
book Mastering AutoCAD. Contact 
Brian at cad-a-blog.com.

AutoCAD 2019

Figure 3: Easily access the view controls in the new dropdown on the ribbon.

Figure 4: A mouse-over will show what has been overridden in each layer.
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 by: Andrea Alderton

H
ave you ever wanted Autodesk® Revit® to 
do more for you? Have you ever wished all 
the information that is populated inside 
elements would do more for you? Well it 

can! Revit has a way to make schedules “smart.” Revit 
allows for the input of formulas for calculations and 

it associates that information with the elements in the model. 
The smart schedule shows elements that exist in the model 
with their information; calculations are based on information  
populated in the model; and changes 
made in either place will directly 
reflect in the other. 

How is this done? In order for 
everything to work together, 
three things are needed: Shared 
Parameters, Families, and Schedules. 
The foundation for bringing smart 
into your schedules is by using shared 
parameters. You can have a single 
shared parameter file with different 
groups of parameters as needed. You 
can also create a shared parameter 
file for each schedule you want to 
create. These shared parameters 
are the link from the family  
to the schedule.

The schedule type we will be using 
is a quantities schedule, the most 
common type of smart schedule 
used. These schedules allow you to 
schedule based on model category 
and they pull their information from 
the shared parameters that are loaded 

into the family and schedule. When creating a quantities schedule 
you will choose the desired parameters and build your own 
schedule. The customization/creation of these schedules involves 
the following: Fields, Filter, Sorting/Grouping, Formatting, 
Appearance, Embedded, and Phasing (Figure 1). 

Fields acts as a parameter manager for the schedule. This tab allows 
you to add parameters, remove parameters, arrange the order of 
parameters, and provides the ability to create a calculated value 

➲

Making 
Schedules 
Smart

Figure 1
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parameter (Figure 2). As a rule of thumb, I never add a parameter 
from the left to the right. To ensure that the correct parameter is 
being added I always use the Add Parameter button and load it 
from the appropriate shared parameter file. Once the parameters 
are added use the Move Up and Move Down buttons to arrange 
the order as desired. An example of how to use the Calculate Value 
button is shown in Figure 2. Name the parameter for the calculated 
value (Area). Adjust settings as needed and then put in the formula. 
In my example I am referring to the parameters Length and Width 
that must already exist in the schedule parameter options. 

Next, the Filter tab will help you sort through your scheduled 
model category items. In the instance where you want to schedule 
Air Handling Units, the entire model category of mechanical 
equipment will not work for this schedule. There are many 
different ways to filter and all of them depend on the desired 
outcome. However, this filter will be based on a parameter that 
exists in the schedule and equipment. An example of two different 
parameters to filter by are Mark and Schedule Number (Figure 3).
 

The Sorting/Grouping tab (Figure 4) will help to arrange the 
order in which the families appear. This can show all instances of 
the families or show one type. The type option is quite nice when 
working with something such as a diffuser where you would not 
want every instance to schedule. This tab also allows Headers, 
Footers, and Grand totals that are all beneficial in their own way. 
Try them out! 

The Formatting tab shown in Figure 5 is where the fun begins. 
Here the generic orientation and alignment are taken care of. The 
fun part is making Hidden fields, applying Field Formats, and 
applying Conditional Formats. Hidden fields are nice if there is 
information valuable to you in the schedule, but you don’t wish to 
print the information. Simply make it a hidden field while printing 
and turn it back on when needed. Field Format will adjust the 
parameter units independently of the base parameter units and 
project units. 

Figure 2 Figure 4

Figure 5

Figure 3

http://www.augiworld.com
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The Conditional Format option gives preset options to adjust how 
cells appear in the schedule. I use this in QC schedules to alert 
me to either discrepancies or potential inaccuracies that could 
cause issues. For example, if my CFM is greater than 3000, the cell 
will turn red and then I know that something is not correct (see 
Figures 6 and 7). 
 
The graphics and text options for the schedule reside on the 
Appearance tab (Figure 8). These can be adjusted per schedule 
or a view template can be applied in order to keep appearance 
consistent among all schedules for the project. 

Every schedule has an assigned Phase and Phase Filter similar to 
views. Schedules can have a phase set to show elements as desired. 
This can help when phases are used in a project for different 
submittals. If there will be schedules for each phase, then assign 
the appropriate phase to the schedule so only elements of that 
phase will populate. On the flip side, the phase filter can be set to 
show all and include elements of all phases in the schedule. 

Embedded schedules are an option inside some Quantity Schedules. 
The option is available in the following model categories: spaces, 
duct systems, piping systems, and electrical circuits. This allows 
you to include information from more than one model category 
and can be found on the Fields tab. 

Now that the schedule aspects have been covered, it’s time to talk 
about parameters in families. How do we make these parameters 
work for us? We use formulas! These can be as simple as: 

+ add
- subtract
* multiply
/ divide

Some simple and common formulas that can be used in family 
creations are half lengths, half widths, radius/diameter, offset 
values. Examples of these follow.

Half Length = Length / 2
Half Width = Width / 2
Radius = Diameter / 2
Diameter = Radius * 2
Frame Offset = Length + 2” 

Complex parameter formula examples: 
If (x, *yes*, *no*) If statement
If (x, *yes*, if(x, *yes*, *no*)) Nested If statement
If/and statement
NOT(*checkbox parameter*, *yes*, *no*) Parameter reading 
from checkbox

There’s a saying, “Google is your oyster.” Oh wait, that might just 
be my interpretation. I use Google a lot for finding formulas to use 
in family creations. 

Some model category families have a Room Calculation Point 
option in the Family Types dialog. This will make a small dot with 
a line attached to your element that is only visible in the family. 

Figure 6

Figure 7

Figure 8

http://www.augi.com
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When this is inside a space it will read the space information and 
relay it back to the family. These come in handy when scheduling 
the room name or number in which the elements resides because 
it will automatically populate in your schedule with zero effort on 
your part. 

Basic formulas build into complex formulas, which build 
into nested formulas, which lead to you being able to achieve  
great things. 

I have used shared parameters in a family to relay information 
to the schedule and populate parts of it based on visibilities and 
connections. An example is the Area Alarm panel schedule. If the 
Area Alarm panel has connections for vacuum, oxygen, and air, 
then those boxes are checked in the Properties panel for the family 
(Figure 9). That information is relayed to the schedule and puts an 
“X” in the schedule for what gases the panel contains. The Room 
Name and Room Number shown are populated from the Room 
Calculation Point.

I have also used formulas and shared parameters to read a pipe 
connection size and input the information in the schedule. The 
connection information works by assigning a pipe size parameter 
to the pipe connector inside the family. A text shared parameter 
exists in the schedule and reads the connection size while 
converting the pipe size parameter to a text parameter. Last, a 
yes/no parameter exists in the family to identify if the connection  
point is used. 

Example of the aforementioned formula and parameters required: 

OSize – parameter, pipe size, exists in the family at the point of 
connection, instance

Schedule O – parameter, text, exists in the schedule, instance

O – parameter, yes/no, exists in the family, instance

Formula: Schedule O = if(not(O), “ “, if(OSize = 0’  0 1/2”, “1/2”, 
if(OSize = 0’  0 3/4”, “3/4”, if(OSize = 0’  1”, “1”, if(OSize = 0’  1 
1/4”, “1 1/4”, if(OSize = 0’  1 1/2”, “1 1/2”, if(OSize = 0’  2”, “2”, 
if(OSize = 0’  2 1/2”, “2 1/2”, “ “))))))))

Formula explained in words: If the O system does not have the O 
box checked, populate the schedule with a space. If the O system 
does have the box checked and OSize is equal to 0’ 0½”, populate 
the schedule with ½” (repeat for all sizes shown). 

The pipe size parameter will adjust to the size of pipe connected to 
the pipe connector. The sizes listed in the formula are all the typical 
sizes for connection. Side note: If you draw from the connection 
point, this does not work. You must draw the pipe and connect to 
the connection point. See Figure 10.

This completes my brief look into making Revit schedules work 
for you. An in-depth article on Revit schedules would take pages 
upon pages, so if you have questions about what is presented here, 
please feel free to reach out to me via LinkedIn. 

Andrea Alderton is the BIM Admin-
istrator at Specialized Engineering 
Solutions in Omaha, Nebraska. An 
Autodesk Revit Architecture 2013 
Certified Professional, Andrea has 
been in the MEP industry for nearly 
nine years, working on projects from 
small two-room renovations to mul-
timillion dollar University buildings 
and hospitals. She has a passion for 
learning, teaching, thinking outside of 
the box, and asking “why?” Connect to 
Andrea on LinkedIn. 

Figure 9

Figure 10
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A Recap:  
Advice I Give 
Myself, Part Two

by: Mark KikerCAD Manager

I
t is always good to review. So let’s review last 
month’s article (AUGIWorld, March 2018). 
We covered seven traits that I keep reminding 
myself need attention. I suggested that you 

think of these as approaches, habits, mindsets, ways 
of thinking, modes of practice, leanings, frames of 

mind, perspectives, and so on. 

Last month I reminded myself of some items such as providing 
great customer service, the value of communication, sharing 
knowledge, taking initiative, being proactive and organized, and, 
finally, planning as a way of life.

Here is the next batch. These are the things that I keep telling 
myself. They are posted on my bulletin board. They are reviewed 
from time to time when I need some refreshing of my focus.

BE QUALITy DRIVEN
Take pride in the work you produce. Work to a level that is beyond 
“good enough.” You should not think you have done a great job just 
because no one complains. You may have done a lousy job and they 
may be complaining to others. Test and verify solutions. Strive for 
best outcome. Stay with a task or problem until the end user is 
satisfied. Avoid  “do overs.”  Do not have an attitude of “I can just fix 
it/finish it later.” Act as if your name is stamped all over the work 
you are doing (it actually is—make it a good thing). 

➲

Everything you  
“do” says something 

about “you”

http://www.augi.com
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DoCUMENTATIoN
Document and share processes, procedures, access, and controls.   
This is so hard to do—going back at the end of a job and writing 
down what you did or what you set up takes time. Yes, this is time 
that could be spent elsewhere, but not time that could be spent better. 
Understand that everything that is done in a shared environment of 
support needs to be documented and stored in a shared location, 
secured as needed. Create documentation that non-support staff 
can also use as applicable. Develop “cheat sheets” to help end users. 
Go on a deep dive for the tech heads out there that might come after 
you. Get it out of your head and on (digital) paper.

REPoRTING
Notify stakeholders of progress, problems, and completion.  Keep 
stakeholders informed as the project progresses.  Notify everyone 
about delays and roadblocks.   Understand that a job is not done 
until all stakeholders know that it is completed.   If you finish 
something and do not tell others, then they are delayed in taking 
the next steps, so they need to know about completions. Fixes must 
be reported so others can then move forward on cascading efforts 
that were held up. Producing progress reports in a timely manner 
helps others know that you are still focused on their issues. Quick 
reports can help others focus on other things and not worry about 
what you are doing.

HAVE A PLAN B
Yes, a Plan B, and C, and maybe D. Defining back-out strategies as 
part of planning is wise. We talked about planning in the March 
2018 article. Planning contingencies in case of failures is a good 
idea. Plan B might come into play at any time. Quickly developing 
options if things derail comes from good prep and working 
contingencies into your planning.   Don’t be overly optimistic to 
the point of not thinking about things going wrong.   Something 
always goes wrong, takes too long, does not work, or breaks. You 
need to have a Plan B and know when to put it into action.

BE A TEAM PLAyER
Working well with others is part of everyday work processes. You 
have to know when and how to hand off work and delegate to 
others. Teamwork can be defined in many ways. Here is a synopsis 
of what I once wrote on my blog. 

Good team players work toward a common goal.  This may 
seem like a commonly understood perspective, but I have seen 
teams drift off track and lose sight of the goal. I have seen 
teams that do not agree on the goal at all. These should be the 
first questions asked and the ones that are reviewed from time 
to time to see if you are still heading in the right direction. 
What defines success? 

Good team players share common methods.  They are not 
little robots, programmed to do just one thing, but they do 
share a common approach to getting things done.  Teams may 
not start this way, but they need to agree on how the goal will 
be reached.   The teams that operate the best are those that 
first agree on how they will tackle the process of reaching the 

goal.   Sometimes the process is defined up front and other 
times it is defined as you move forward.  Either way works, as 
long as the team understands who is doing what.

Good team players document the process and the results. This 
goes back to my documentation topic. The goal is not the only 
milestone that is achieved as the team progresses.  It may be 
formal or informal, but you need to document what is agreed 
to so everyone stays on the same page.  Writing it down and 
distributing it causes you to clarify and review as you go.   
Everyone contributes and reads the notes from a meeting and 
they are verified so all agree to the decisions that are written 
and not just what they think was said. I have found so many 
times that written reviews force people to see what was said. 

Good team players work as a team.  An obvious statement, 
but so often not applied.  Every member of the team stands 
or falls on the collective outcome of the team.   But many 
bring personal agendas and goals that counteract that effort.  
Ferreting out these silent agendas may be tough, but they need 
to be uncovered and addressed or corrected. And don’t bring 
your hidden agendas into a team process. Not good.

Some of you may have taken a few tips from this article that can be 
put into place. Or at least pondered. More to come next time. Until 
then, keep on thinking.

Mark Kiker has more than 25 years 
of hands-on experience with technol-
ogy. He is fully versed in every area of 
management from deployment plan-
ning, installation, and configuration 
to training and strategic planning. As 
an internationally known speaker and 
writer, he is a returning speaker at  
Autodesk University since 1996. 
Mark is currently serving as Direc-
tor of IT for SIATech, a non-profit 
public charter high school focused on 
dropout recovery. He maintains two 
blog sites, www.caddmanager.com and  
www.bimmanager.com.

CAD Manager

Quickly developing 
options if things derail 

comes from good prep and 
working contingencies 

into your planning 

http://www.augiworld.com
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by: Kimberly Fuhrman

Manage 
This!
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I 
am guilty of it. A new building assignment, a 
fresh Revit® project, and all you want to do is 
get in there and start modeling! Then, partway 
through you realize there are some things Revit 

should have had before you started the project. Some 
things that can wreak havoc if you have to go back and change them 
after you have already started modeling. Here are a few things to 
check before you start modeling.

MANAGE TAB
Just my very humble opinion, but the Manage tab should be first in 
the Revit lineup. You can change any of the tab locations on your 
ribbon by holding the CTRL button and dragging the tab. 

This creates a subtle reminder to check project settings first. 

SETTINGS
Working across the Manage tab, the first panel is the Settings 
panel. Materials and Object Styles can be set in a template file by 
your BIM manager. There will also be additional Materials created 
that are project specific, so those can be revisited later as you go 
along. Snaps are something I’ve only changed a few times in the 
many years I’ve been working with Revit, but you can set your 
preferences here. Snaps may be turned on or off globally, or Snaps 
may be turned on or off individually. Snap increments for both 
linear and angular dimension snaps can be modified as well.

Project Information lists parameters that are specific to the current 
Revit project—project name, owner’s information, typical title 
block fodder. Energy Settings for analysis purposes can also be set 
in the Project Information, or on the Analyze tab.

The middle section of the Settings panel is dedicated to Parameters—
Project Parameters (those specific to the current Revit project), 
Shared Parameters (applied to multiple projects and families), and 

Global Parameters (used to control other parameters). Set as many 
of these as possible before starting, especially if you are using Global 
Parameters to drive the values of dimensions or other parameters. 
If you are collaborating with a team, you will want to make sure 
everyone is using consistent Shared Parameters. Otherwise, 
schedules and tags will become very cumbersome.

Transfer Project Standards is a fantastic tool when used properly. 
With Transfer Project Standards, you can copy Family Types, 
Object Styles, and many other settings from one project to 
another. Unfortunately, many users abuse this by copying from one 
project to another, over and over. It is important to have a system 
in place to manage items that continually are reused. Data that 
is continually reused in a legacy fashion is more likely to become 
corrupt. If objects are continually reused, consider incorporating 
into templates or libraries.

PURGE UNUSED… my favorite command available! When a 
user comes to me and complains that the model is running slow, 
the first thing I’m going to ask is if they have purged lately. And the 
answer is usually something like, “I don’t want to lose anything.” 
Okay, key word here is “unused,” meaning you’re not using it! So, 
get rid of it! It’s bogging down your model, and you don’t need 
it. Chances are you won’t need it, and even if you do, it’s not that 
difficult to reload a family. Also, you can select which families to 

purge, so if there is something 
you really have a grip on, 
uncheck the box and it won’t 
be removed from the project. 
Purge often!

Project units are usually fixed. 
The one thing I usually check 
is the accuracy of the length 

➲

Figure 1: Manage tab first!

Figure 2: Settings panel of the Manage tab

If you are collaborating 
with a team, you will 
want to make sure 
everyone is using 
consistent Shared 
Parameters. otherwise, 
schedules and tags 
will become very 
cumbersome.
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units. For those of us stuck in Imperial units, set the length 
accuracy to 1/256”. This will ensure that your model is accurate, 
and will eliminate errors due to rounding, especially critical with 
steel measurements.

STRUCTURAL SETTINGS
Hidden in a tiny button on the Settings panel are the Structural 
Settings. Before starting structural modeling, check these settings. 

This will save you from headaches later. Cutback Distances, 
Symbolic Representations and Load Calculation, and Analytical  
settings all reside within this tiny button that’s often overlooked.

AND THE REST…
The remainder of the Manage tab includes other general settings 
that will most likely be managed by templates or company 

standards. The one command I will highlight is the Phases button. 
If at all possible, set the Phases at the start of the project. Phases 
must be consistent through linked Revit projects (Architecture/
MEP); otherwise, visibility controls and project management will 
be utterly impossible.

START WELL, END WELL
The more you can set from the beginning of the project, the easier 
it will be to continue and complete the project. If something needs 
to be adjusted at the start of every project, consider making those 
settings permanent in a template. Management doesn’t mean a 
higher status in the company… management means taking care of 
your projects from start to finish. Manage this!

Kimberly Fuhrman, LEED AP 
BD+C, is a Sr. BIM Technical Spe-
cialist for EDGE-Global Technology 
Solutions. She serves on the AUGI 
Board of Directors, as well as the 
USGBC-Central PA Community 
MLAB. She also participates in the 
Autodesk Developer Network and is a 
member of the Autodesk Expert Elite 
program. Kimberly has been a pre-
senter at Autodesk University, Mid-
west University and BILT NA. In her 
spare time, she is a regular contributor  
to cadpanacea.com.

Figure 3: Structural settings

Figure 4: Structural settings dialog
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REoPEN
https://timclassen.com/

ReOpen opens all Autodesk® Inventor® windows 
exactly the way they were being used before the 
Inventor was last closed, allowing you to continue 
working right where you left off.

Via “ ‘Re-Open’-Settings” (“Get Started” -> “Launch” -> “ ‘Re-
Open’-Settings”), you can configure the program to automatically 
ask whether you would like to restore the windows from the last 
session of Inventor when you start the program. You can also 
reopen the windows from the last session via the “Re-Open” 
menu item in the Inventor menu (“Get Started” -> “Launch” ->  
“Re-Open”).

AUToExCEL
http://bit.ly/2HuZh3Y

With AutoExcel, you will be able to quickly export 
and re-import any Autodesk® Revit® project 
schedule to Microsoft Excel. Process includes:

1. Open any project schedule and click “export”
2. Modify the Excel generated file
3. Go back to the same project schedule and click on “import”

Great for modification of many parameters in a single step. Use 
Excel to organize your data and parameters.

This is a 30-day trial version. To purchase this app, visit shop.
bimize.com. For more information, visit www.bimize.com

AREAMARkER
http://bit.ly/2FFIwT4

AreaMarker is an AutoCAD® app that allows you 
to get areas of CAD objects and regions quickly and 
mark the results in the drawing. Then you can also 
export the results to CAD Table or Excel.

You can start AreaMarker by the main shortcut “FF,” which is the 
easiest and recommended way.

And you can also start AreaMarker with the following shortcuts:

Options include:
•	 By picking an internal point, AreaMarker will automatically 

generate the boundary and mark the area at the center point.
•	 By selecting objects in AutoCAD, AreaMarker will mark 

areas at the center points.
•	 You can also export the results to Excel after marking.
 
Supported versions: AutoCAD 2015 - 2018.

If you have some news to share with us for future issues, please 
let us know. Likewise, if you are a user of a featured product or 
news item and would like to write a review, we want to know:  
brian.andresen@augi.com

Welcome to AUGIWorld Inside Track! Check out the latest opportunities to 
advance your skills, processes, and workflows in your firm with the most current  
AEC-related software and hardware updates available.

by: Brian Andresen

AUGIWorld
brings
you recent
developments
in Autodesk
and related
software
items

http://www.augi.com
https://timclassen.com/
mailto:brian.andresen@augi.com
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by: Melinda Heavrin

START TAB

W
hen you start the program, open a 
new tab (+), or close the last drawing, 
a Start Tab is displayed (see Figure 
1). Each Start tab (formerly the New 

tab) contains the Create Page and the Learn Page. 
The Create Page is a quick launch 
pad to decide what to do, and 
contains the following sections.  
•	 Get Started
•	 Start New Drawing
•	 Templates
•	 Open Files
•	 Open a Project
•	 Open a Sheet Set
•	 Explore Sample Drawings
•	 Recent Documents
•	 Connect

The Learn page provides access to 
learning resources such as videos, 
tips, and other relevant online 
content or services. For every new 
content update, a notification 
badge is displayed at the bottom 
of the page. Note that if there is no 
Internet connection, the Learn page 
is not displayed.

You can use Ctrl+Home or 
GOTOSTART to get to the 

Start tab quickly. If you don’t want the Start tab to display, set 
STARTMODE to 0.

SMooTH LINE DISPLAy
AutoCAD® Architecture has a solution to the jagged diagonal lines 
that you sometimes see in 2D wireframe drawings. The command is 

➲

Tips & Tricks

Figure 1: Start tab
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LINESMOOTHING. This variable can also be found under the 
Options dialog box, System tab. Click on Graphics Performance 
and the Graphics Performance dialog box appears. Checking 
Smooth Line Display removes the jagged lines. If your hardware 
supports High Quality Geometry, you can select the new “High 
Quality Geometry” option in the Graphics Performance dialog on 
the Status bar. Hardware acceleration must be turned on for this to 
work. Set LINEFADING to 1 to automatically fade geometry as 
you zoom into super-dense drawings. You can control the amount 
of fading with LINEFADINGLEVEL.

DIGITAL SIGNATURES
AutoCAD Architecture offers extra security controls that help to 
protect your drawings. You will find a variety of Security Options 
on the System tab of Options. One option is Digital Signatures, 
now accessible via the new DIGITALSIGN command. A digital 
signature is a block of encrypted information that you can add to 
certain files to identify the originator and indicate whether a file 
has been altered since the digital signature was applied.

To attach a digital signature to a file, you must either have a digital 
certificate issued by a certificate authority or you can create a self-
signed certificate using one of several utilities. 
You can examine a file’s digital signature. 
This is important when you are working on 
collaborative projects or if you receive an 
executable file. For drawing files, an icon is 
displayed on the status bar if a drawing file is 
digitally signed. When you click the icon, you 
can verify information such as the validity of 
the signature, the name of the individual or 
organization that signed the file, and so on.

STATUS BAR
The status bar can automatically wrap onto two 
rows when there are more icons than can fit into 
a single row. At any given time, the Model tab 
and at least one layout tab is always displayed. 
You can populate the status bar with the tools 
you want by clicking on the three-stacked lines 
in the lower-right corner of the editor (see Figure 
2). Isolate Objects and Lock UI have been 
added to the status bar customization menu. 
The Lock User Interface tool on the status bar 
enables you to check and uncheck multiple UI 
elements at one time instead of having to reopen 
the flyout each time. You can click the icon to 
enable or disable UI locking. Also, note that 
the previous text “Cut Plane:” has been replaced  
by an icon.

ACA REVISIoN CLoUD
The Revision Cloud tool is enhanced to provide 
more flexibility. It is accessible from the Annotate 
ribbon panel and includes three methods of 
creation: Rectangular, Polygonal, and Freehand 
in addition to the Command line option to select 

an object. The last used creation method is remembered the next 
time the command is run. You can set your own default creation 
method using the REVCLOUDCREATEMODE system variable. 
Whether you create rectangular, polygonal, freehand, or object 
revision clouds, editing their size and shape with grips is intuitive 
and easy. The number of grips displayed for revision clouds has 
been significantly reduced. The location and behavior of grips is 
based on the shape of the revision cloud. If you prefer legacy display 
of grips you can set REVCLOUDGRIPS to Off. In addition to 
easier editing with grips, a new Modify option allows you to draw 
new revision cloud segments and erase selected portions of existing 
revision clouds (put several revision clouds together).

3D PRINTING
AutoCAD Architecture has made it easy to send your designs 
to a 3D printer. Publish, in the Application menu, gives you the 
option to Send to 3D Print Service. Print in the Application menu 
gives you the option to choose Print Studio. After choosing one 
of those options, the 3D Print Options dialog box will appear. 
This dialog box allows you to select objects and control output 
dimensions. Select OK and you will be asked to save the output 
file to STL format so it can be sent to a 3D Print Service. If you 

Figure 2: Status bar
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choose Print Studio, you will have access to additional tools to aid in 
prepping your model for printing when sending to your 3D printer.  
You may be prompted to install Print Studio as it is not  
installed by default.

LASSo SELECTIoN FoR oBjECTS
Lasso Selection is an object selection feature that can be created 
by clicking, dragging, and releasing the mouse button (see Figure 
3). You can drag from left to right to select all objects that are 
entirely enclosed in the lasso or drag from right to left to select all 
objects that are crossed by the lasso. Click Enter. You can deselect 
objects by pressing shift and then clicking the individual objects or 
dragging across multiple objects. Press Esc to deselect all objects. It 
is important to note that when using lasso selection, you can press 
the spacebar to cycle between the Window, Crossing, and Fence 
object selection modes.

SHARE DESIGN VIEWS
You can publish design views to a secure, anonymous location 
within Autodesk A360. You can share views of your design by 
forwarding a generated link to the people you specify without 
releasing the DWG file itself. Access to these views is provided 
by any supported web browser and does not require recipients to 

have an Autodesk A360 account or install any additional software. 
Supported browsers include Chrome, Firefox, and other browsers 
that support WebGL 3D graphics. Once you have the design view 
established, you can share the link with other users. This link is 
valid for 30 days but you can extend it for an additional 30 days at 
any time indefinitely.

SMART DIMENSIoNS
In AutoCAD Architecture, the DIM command is accessible from 
the ribbon and is smart enough to detect objects and provide 
various visual dimension options. The DIMLAYER command 
can be used to create a new layer for dimensioning. You are given 
horizontal, vertical, and aligned dimension previews when you 
select a linear object. From these previews, you can simply place the 
desired dimension. You can also select another non-parallel linear 
object to display and place an angular dimension. You can specify 
a type of dimension by using the various dimensioning options in 
the right-click menu. The default values are automatically assumed 
for the dimension text and angles, but you can still change them 
from the right-click menu or command line. The DIM command 
remains active until you exit the command, allowing you to knock 
out multiple dimensions at one time. You can use the width sizing 
control to wrap dimension text, which is a great addition!

Figure 3: Lasso selection
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Figure 4: PDF options

PDF ENHANCEMENTS
AutoCAD Architecture has continued improvements for 
importing geometry, TrueType text, and raster images from a 
PDF. You can use the PDF Import tool to import geometry from 
a PDF page into the current drawing as AutoCAD Architecture 
objects. After selecting a PDF file, you can use the Import PDF 
dialog box to customize your import. You can choose which page 
of the PDF file to import and specify scale, rotation, insertion 
point, type of data to import, and so on. If you choose not to apply 
lineweight properties, AutoCAD Architecture will use the default 
lineweight. The PDFIMPORT command offers the option of 
selecting an attached PDF underlay. This option is found in the 
contextual PDF underlay ribbon tab. You can specify a polygonal 
or rectangular boundary around the objects you wish to import or 
you can choose to import the entire underlay.

When using the Plot tool to create PDF files, you can now choose 
from four predefined PDF presets offering a quick way to apply 
different PDF output options that meet various needs. If you 
select any PDF pc3 from the printer/plotter drop-down list, a 
PDF Options button is displayed, providing convenient access to 
the PDF Options dialog (see Figure 4). Similar PDF presets and 
options controls are available when creating PDF files with the 
Export to PDF and Batch Plot tools. 

The Sheet Set Manager has also been updated to support these 
PDF enhancements. Layout names are automatically displayed as 
page labels in the PDF file, making it easy to identify sheets when 
viewing the PDF.

TExT ALIGNMENT AND TExT EDIT
AutoCAD Architecture has a TEXTALIGN command that 
allows multiple text objects to be aligned to a base object and 
provides a preview of the result. After typing TEXTALIGN, 

the prompt Select text objects to align [alignment Options] is 
displayed. Select two or more objects to align and press Enter. 
With this command, you can easily control the spacing or 
alignment direction.

The TEXTEDIT command has a new “multiple” option that 
allows you to perform multiple text edits as one time. There is 
also an Undo option within Multiple mode that allows you to 
undo Individual text edits. It is important to note that if you leave 
TEXTEDIT and perform an undo, all of the edits within the 
TEXTEDIT will be undone.

LAyER MERGE
Layer Merge (LAYMRG) can be found in the Layer Manager in 
AutoCAD Architecture. At the command prompt, you can enter 
LAYMRG. Then in the drawing area, select an object on each layer 
that you want to merge and press Enter. Next select an object on 
the target layer. All objects on layers that contain objects in the first 
selection set are moved to the target layer.

You can also do this using the Layer Properties Manager. Select 
the Home tab of the ribbon, Layers panel, and then select Layer 
Properties. In the Layer Properties Manager, select the layers 
you want to merge into another layer and right-click and select 
Merge Selected Layers To (see Figure 2). You will need to press 
Ctrl+click to select more than one layer. In the Merge to Layer 
dialog box, select a target layer. Objects on the merged layers are 
moved to the layer you select in this dialog box. The now empty 
layers are automatically deleted.

RENDERING
The rendering engine in AutoCAD Architecture is easy to use 
and yields great results. The Render ribbon panel on the Render 
ribbon tab supports the rendering engine. It includes a size drop-
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down where you can quickly select from standard pre-defined 
render sizes (see Figure 5). 

The Render Presets list includes additional options enabling you 
to control the render quality by setting either the number of levels 
to render or how much time to render. The new Render Presets 
Manager is much simpler than the previous Render Presets 
Manager. You can create, modify, and delete custom Render 
Presets. Specify Render Preset name and description as well as the 
duration and accuracy. You can render directly from the Render 
Presets Manager, choosing to render in the Render Window, the 
current viewport, or a specified region in the current viewport. 

When rendering in the render window, a drop-down list enables 
you to select from a list of standard render output sizes or choose 
More Output Settings to access the new Render to Output Settings 
dialog box, in which you can specify the image size and resolution. 
You can also choose to automatically save the rendered image to a 
file including BMP, TGA, TIF, JPEG, and PNG formats.

A new Render Environment & Exposure palette offers powerful new 
Image Based Lighting (IBL) environments. When the Environment 
control is turned on, you can select from pre-defined, image-based 
lighting environments. The image-based lighting environments 
automatically apply lighting effects. Some of them include 360 
background images that emulate a realistic environment as you orbit 
around the model. The viewport must be in a perspective view and 
you must render to see the IBL environment.

A control in the Render Environment & Exposure palette 
enables you to use a custom background image. Custom images 
are static and do not emulate a realistic 3D environment as 
you rotate. Additional controls in the Render Environment 
& Exposure palette enable you to adjust the Exposure and  
White Balance. The Exposure slides between Bright and Dark. 

The White Balance slides between 
Cool and Warm. The new render 
window displays the current 
render process and allows you to 
save a snapshot, zoom in and out 
while rendering, and print the 
rendered image. Render history is 
displayed in the expanded section 
of the render window.

GEoGRAPHIC 
LoCATIoN
Geographic location information 
in a drawing file is built around 
an entity that is known as the 
geographic marker. The geographic 
marker points to a reference point 
in model space that corresponds 
to a location on the surface of 
the earth of known latitude and 
longitude. The program also 
captures the direction of the north 

at this location. Using this information, the program can derive the 
geographic coordinates of all other points in the drawing file. You 
can set a geographic location using the Set Location tool on the 
Insert tab of the ribbon, then easily search for an address from a 
map and drop a marker on the map to mark the spot. Drawing 
units can be easily modified. 

After you insert a geographic marker in a drawing, you can do any 
of the following:
•	 Make the program automatically determine the angle of 

sunlight when you perform sun and sky simulation.
•	 Insert a map from an online maps service in a viewport.
•	 Perform environment studies.
•	 Use position markers to mark geographic locations and record 

related notes.
•	 Locate yourself on the map in real-time on systems that 

support location sensing.
•	 Export to AutoCAD Map 3D and expect the model to 

position itself automatically.

You can remove geographic location information from a drawing 
file using the GEOREMOVE command. The geographic marker 
and GIS coordinate system are removed from the drawing file. 
However, position markers will remain in the drawing file.

Melinda Heavrin is a CAD Coordi-
nator & Facility Planner in Louisville, 
Kentucky. She has been using Auto-
CAD Architecture since release 2000. 
Melinda can be reached for comments 
and questions at melindaheavrin@
windstream.net.

Figure 5: Render to Size
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that will bring you more benefits than ever before. 
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to share with fellow members, plus provide an 
expanded, more interactive website, publication 
access, and much more! 
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Basic members have  
access to:
•	Forums
•	HotNews (last 12 months)
•	AUGIWorld (last 12 months)

DUES: Free
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access to:
•	Forums
•	HotNews (last 24 months)
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AutoCAD Civil 3D 2019 by: Shawn Herring

What’s 
New in 
Civil 3D 
2019?

J
ust installed AutoCAD® Civil 3D® 2018? 
Maybe just downloaded Civil 3D 2018.1 
or 2018.2?  Well never fear….2019 is here!  
That was somewhat sarcastic, but I do see 

some much-needed improvements to AutoCAD 
2019 and its vertical products such as Civil 3D.  

You saw throughout the year that with most Autodesk products 
you get periodic updates.  Civil 3D 2018.1 and 2018.2 were solid 
updates, and there are a few items in 2019 that I think are great.

This article looks at some of the top new features within AutoCAD 
Civil 3D 2019 and may help you make your decision to download 
and install today.

VERSIoN INTERoPERABILITy
The AutoCAD format for 2019 is also the 2018 format introduced 
last year, meaning 
you should have no 
problem going back 
and forth between 
2018 and 2019.  
Good, that’s out of the 
way. Now on to the 
important stuff! 

DWG CoMPARE
Compare two versions of a drawing
DWG Compare is a fantastic addition to AutoCAD-based 
products such AutoCAD Civil 3D.  You can now quickly review 
changes to drawing features such as 2D linework, Civil 3D objects 
(Pipes, Surfaces, etc), text, and pretty much anything within 
your drawings.  It’s available in the main Application menu when 
no drawing is active or under Drawing Utilities when there is a 
drawing active. You can also access it from the new Collaborate 
ribbon tab (Figure 1).

Once you select DWG Compare, the dialog box will ask you to 
select which two drawings to compare, it will then create a third 
drawing with the two overlaid.  Prior to selecting COMPARE, you 
can modify the color choices if you wish (Figure 2).

➲

Figure 1
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AutoCAD Civil 3D 2019

The results of the comparison are displayed in the automatically 
created third drawing. Three categories of objects, or parts of 
objects, are displayed. Those which are located only in the first 
drawing (GREEN), those which are located only in the second 
drawing (RED), and those which are identical in the two  
drawings (GREY). 

A contextual Compare ribbon tab lets you to control the appearance 
of results. This tab has three groups of controls: Comparison, 
Compare Filter, and Change Set.

Again, this may seem like a simple task, but for quick reviews, 
client/city meetings and simple clashes, this tool is a great addition 
for 2019. 

VIEWS / VIEWPoRT UPGRADES
Create a Named View
It’s always fun when viewports get an upgrade, right?  Well, this 
one I like.  I create a lot of saved views within Civil 3D and find it 
easier to bounce back and forth between these saved views from 
time to time.  But what about adding these views to a sheet layout?  
It’s very simple in Autodesk Inventor®, even easier in Autodesk® 
Revit®, so why not Civil 3D?  Check this out!

On the View tab of the ribbon, you now see a Named Views panel.  
Zoom into an area on your screen and select New View.  You can 
then name your view, select current display or define a window, 

and several other options you can explore.  Select OK and your 
view has been created (Figure 4).

Once you have completed the new named view, switch to paper 
space and activate the Layout tab on your ribbon.

From the Layout Viewports panel, you now have an Insert View 
option.  Select Insert View and you will see your saved Named 
View from model space.  Select the view you want to add to paper 
space and add it to your screen.

Want to change the scale?  Select the viewport, select the drop-
down arrow in the middle and choose the scan you would like that 
view to be.  Simple, right?

Figure 2

Figure 3

Figure 4

Figure 5
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CIVIL 3D 2018.1 AND 2018.2 FEATURES 
(NoW IN 2019)
Most, if not all, of the Productivity Pack enhancements have 
been rolled into the software, along with other subscription perks 
throughout the 2018 release.  Some of the following items below 
may be of interest and really help in streamlining workflows and 
enhancing design.

Rehab Corridor
(This is for corridors that have attended one too many  
Autodesk Universities!)  

But seriously, this tool works great for optimizing the cross slope 
of existing roadways or enhancing your design of new roadways 
that just need a bit more detailed design to them.

The workflow to create a rehab corridor is slightly different 
from the standard workflow used to create other corridor 
models. To create a rehab corridor object, you must specify 
a corridor style, corridor layer, a baseline (alignment 
and profile), rehab region start and end stations, and a  
target surface. 

Next, you will use the Rehab Parameters palette to specify 
lane inputs and properties, and modify the rehab input 
parameters such as cross slope adjustments and milling and 
leveling parameters. Once you apply rehab parameters to 

your rehab corridor, AutoCAD Civil 3D will automatically build 
the rehab assembly for your rehab corridor and will automatically 
assign the appropriate rehab and/or cross slope optimization 
subassemblies to your rehab corridor regions. See Figure 6.

Rehab Manager
You can use the Rehab Manager to review parameters and modify 
accepted cross slope values to meet design requirements on a 
section-by-section basis.

Rehab Reports
You can use the Rehab Manager to generate Cross Slope 
Correction and Milling and Leveling reports for selected stations 
within your rehab corridor regions. The Rehab Manager can also 
be used to review violations to design geometry requirements and 
modify rehab parameters on a section-by-section basis (Figure 7).

Infrastructure Parts Editor
Forget partbuilder… finally! Use the Infrastructure Parts Editor 
to customize drainage structure or piping part families and part 
assemblies, then publish them to catalogs that are compatible with 
Autodesk InfraWorks® and AutoCAD Civil 3D.

There are several ways to review, modify, and publish part families 
and assemblies:
•	 You can work with a default library of drainage structure and 

piping catalogs, in Metric or Imperial units.
•	 You can open and modify a parts catalog that is associated 

with a specific Autodesk InfraWorks model.
•	 You can open a part catalog file from your local system in 

.ICBT format.
•	 You can add new parametric parts to your library using .IPT 

parametric shape template files that were created with the 
Infrastructure Part Shape Utilties tools for Autodesk Inventor.

When creating a new part size, it is very simple to key in the sizes you 
want and validate your design.  Drainage Structures are organized 
by Assembly, Structure, and Culvert in the Navigation Panel of 
the Parts Editor.  For Piping catalogs in the Parts Editor, there are 
many types of piping assemblies that can be created using piping 
parts families. For example, you can create a Fittings assembly from 
Adapter, Cap, Coupling, Cross, Elbow, Plug, Reducer, Lateral, Tee, 
and Wye part families, or you could create a Valves and Operators 
assembly using Hydrant, Valve, Valve Actuator, and Valve Body 
part families (Figure 8).Figure 6

Figure 7
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PRoFILE GEoMETRy ENHANCEMENTS
Two new vertical curve options exist.
1. Fixed Parabola by High/Low Point
2. Fixed Circular Curve by High/Low Point

Profile layout direction: Draw fixed profile tangents and lay out 
profiles in either a left-to-right or a right-to-left direction when 
using the Fixed Tangent (Two Points) command and the Draw 
Tangents and Draw Tangents With Curves commands. Previously 
these commands required using a left-to-right layout direction. 

Vertical curves in offset profile slope transition regions: Vertical 
curves are now created in slope transition regions for offset profiles.

Section Views: Use new navigation options to zoom to a section 
view from a sample line, and to zoom to a sample line from a 
section view.

MISCELLANEoUS NEW 
ITEMS
Here are a few other items that are new in 
AutoCAD and its vertical products.

•	Infraworks Component Roads
•	 Infraworks	 Component	 Roads	 now	

translate directly into a Civil 3D 
corridor!  In the Civil 3D exchange 
settings, you can now set default setting 
to get your corridor to translate correctly 
(Figure 9).

•	Reference Template Updates
•	 Will	now	read	DWT	and	DWG	files.

•	Xref Layers
•	 A	 new	 XREFLAYER	 system	 variable	

enables you to specify a default layer 
on which new Xrefs are inserted. The 
Xref layer is only displayed in the Layer 
Manager when an Xref is attached  
to the drawing.

•	 Shared Views 
•	 The Shared Views feature makes it easier for you to share 

your designs with stakeholders within or outside your 
company without releasing your original drawing files.

•	 Creating a Shared View: The Shared View tool can 
be accessed from AutoCAD’s Application menu,  
under Publish.

CoNCLUSIoN
The new and enhanced features in AutoCAD Civil 3D 2019 will 
help in your everyday workflows.

I would love to hear from you regarding the new features as well as 
features you would like to see added or enhanced. Feel free to call 
or email me anytime.

Shawn Herring has been a part of 
the design engineering community 
for roughly 13 years in all aspects 
of design, construction and software 
implementations.  He has imple-
mented and trained companies across 
the Country on Civil 3D and other 
infrastructure tools and their best 
practice workflows. Shawn can be 
reached for comments or questions  
at awautocadcivil3dcm@augi.com.

Figure 8

Figure 9
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InfraWorks

Enhanced 
Functionality 
for Roads, 
Bridges, and 
More

 by: Todd Rogers
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O
n January 25, 2018, Autodesk released 
InfraWorks® 2018.2. This release 
is chock full of new enhancements.  
Here, I’ll explain the new features and 

their functionality. 

RoADWAy DESIGN
Component Road label prefixes have been added so it’s easier to 
tell the difference between fixed stations and horizontal geometry. 

The in-canvas and stack for Spiral editing has added curve radius, 
curve length, and A values for Spiral In and Spiral Out. If you 
click on the values shown in-canvas, you will then be able to edit  
the values.

Right-clicking in-canvas on a road tangent will give you the option 
to Add a Curve (Figure3).

Right-clicking in profile view on a PVI will give you the option 
to Add a Vertical Curve and specify the vertical curve properties 
(Figure 4).

InfraWorks

➲

Figure 1

Figure 2

Figure 3

Figure 4

Figure 5
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InfraWorks

Right-of-Ways, Parcels, and Easements now display length and 
area, which can be edited in-canvas. There is also a new keyboard 
shortcut in case you want to lock the length value (Figure 6).

BRIDGE DESIGN
Parametric bridge parameters can now be viewed in-canvas 
through the Style palette. The configure dialog shows parameters 

from Autodesk Inventor® when configured properly. The size of 
the text has been formatted as well as an import/export option 
(Figure 7).

QUANTITIES AND ANALySIS
You now have the ability to specify a station range for road, bridge, 
and drainage materials. Also, you can perform this same operation 
by selecting an area of interest (AOI) such as a parcel, easement, 
or right-of-way. After you select your AOI, the results are shown. 
These values will update if you adjust the extents of the AOI 
(Figure 8).

Utilities quantities, such as drainage components or generic pipes, 
are calculated by depth range.

PoINT CLoUDS
Realistic information can be shown by using photographic images 
along with point clouds during linear feature extraction and 
vertical modeling (Figure 9).

You can choose to snap or merge the lines when joining two linear 
features (Figure 10).

It’s now easier, in the cross section view, to add vertices for linear 
features (Figure 11). 

There is now a choice to delete a selected feature, or all filtered 
features, by category or height when extracting vertical features 
(Figure 12).

Figure 6

Figure 8

Figure 9

Figure 7
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VISUALIzATIoN
In-canvas labels can now be controlled for viewing in the 
Interaction View Settings dialog (Figure 13).

CoNCLUSIoN
Special thanks to Elliott Rosenfeld of Autodesk for posting this 
on the blog BIMagination. Other learning resources include the 
What’s New Help Index inside of InfraWorks, and the Autodesk 
Civil Engineering Community Center,  http://civil-community.
autodesk.com/.

Todd Rogers is a Customer Success 
Manager and Certified Autodesk In-
structor with more than 23 years of 
experience in teaching, managing, and, 
providing hardware and software solu-
tions for hundreds of engineering firms 
throughout the greater Houston, Texas 
area.  Todd is a valued member of the In-
frastructure Support Division (ISD) for 
Graitec USA (formerly Total CAD Sys-
tems, Inc.). He also holds the “Autodesk 
Expert Elite” status, a program to rec-
ognize individual community members 
who have made extraordinary contribu-
tions with helping customers by sharing 
knowledge, providing community leader-
ship, and exemplifying an engaging style 
of collaboration that drives a healthy and 
valuable Autodesk customer community.  
He is an active blogger. Through his per-
sonal blog website (civil3dj.wordpress.
com), Todd shares tips and solutions for 
Autodesk software issues.  

InfraWorks
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